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“It’s all physics!”

Donny MacNamara
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Preface

Welcome to the wonderful world of physics! The study of physics is useful and impor-
tant because physics is the most fundamental science. It is the framework upon which
other sciences are built. As my old friend the high school physics teacher used to say
“It’s all physics!” Once you understand the basic principles of physics, you’ll find it eas-
ier to understand other sciences. The thinking and problem-solving skills you develop
here will help you in any endeavor.

This goal of this book is to teach undergraduate physics students how to use Scientific
Notebook to solve physics problems. I’ve tried to choose topics that have educational
value, fit within a typical physics curriculum, and show the benefits of SNB. Many prob-
lems come from my class notes, some from my research, while others I included because
they’re interesting. Some are problems I wanted to do in class but couldn’t because the
math was too difficult or time consuming.

Solving real-world problems usually requires more complicated mathematics than the
idealized problems presented in introductory textbooks. Those “easy” problems are a
good place to start. Once you can solve and understand them, we’ll add some compli-
cations and let SNB do the math. This lets us solve interesting, more realistic problems,
and this book will be a useful reference for your entire undergraduate career.

Many of you are training for careers in fields which require technical or scientific calcu-
lations and written reports. SNB, which you can think of as a combination math gizmo
and word processor, is ideally suited for these tasks. You’ll find this inexpensive soft-
ware helpful and easy to use, in the classroom and beyond. However SNB can only assist
you in solving physics problems, it cannot solve them for you.

Physics is not math. In mathematics you learn to solve equations. In physics you learn
to apply equations to describe and explain the physical universe. Physicists construct
equations involving physical quantities that are based on fundamental principals to de-
scribe and explain nature and we use mathematics to solve them. The bad news is that
SNB will not solve any physics problems for anyone. The good news is that is will help
you do physics by helping you with the math stuff. You do the physics, SNB does the
math. You create the equation, SNB solves it. SNB will make the graph, but you will
have to interpret it.

Undergraduate physics is taught with varying degrees of mathematical rigor, from fresh-
men no-calculus science-major courses to upper-level lots-of-calculus courses for physics
majors. Not all physics classes use calculus so many students learn physics without it.
But omitting calculus from a book about Doing Physics with SNB is like warping with
one nacelle tied behind your impulse drive. The calculus and no-calculus problems are
usually in separate sections, with the more complicated sections at the ends of chapters.



xvi Preface

In Chapter 1, I introduce you to many SNB features I have used to solve physics prob-
lems. There are many more features of SNB, and the best way to learn them is to explore
and play with SNB. Excellent written documentation accompanies SNB and it has an ex-
tensive built-in help system, all of which was written with SNB. If you see it in the help,
you can do it with SNB. You can even cut-and-paste from the help into your document.
The Help + Search feature is a great place to start when you need help or information.

In the subsequent chapters, I follow the basic introductory physics curriculum, extending
it to include interesting problems (some with calculus but all at the undergraduate level)
that show the power and usefulness of SNB and let your skills grow. Each section has
a brief introduction to the relevant physical concepts. Since this is not a comprehensive
physics textbook, I emphasize problem solving over conceptual knowledge, although
both are important.

At least one example appears in almost every section. Their purpose is to enhance your
understanding of the relevant physics and to provide detailed instructions on using SNB.
You can (and should) explore the topics further with the wide selection of problems at
the end of each chapter.

The two Appendices at the end of the book contain special topics in classical and modern
physics that are not typically part of the traditional undergraduate physics curriculum.
These are topics I find interesting, important or curiosity-inducing. They also show just
how powerful SNB is as a problem-solving tool.

This book uses the following notation and conventions:
• The abbreviation SNB refers to Scientific Notebook. Really.

• Words written like Evaluate and Plot 2D Rectangular refer to SNB menu com-
mands, buttons, and options.

• Notation like Compute + Evaluate means click on the Compute menu item and
select Evaluate.

• Notation like Help + Search, Tags means click on the Help menu item and select
Search. When the input box appears, type Tags.

• Words written like TAB and CTRL refer to a key on your keyboard.

• Notation like CTRL + F means hold down the CTRL key, press the F key and release
the two keys simultaneously.

• Important physics words like force appear in bold face the first time you meet them.

• Shaded gray boxes contain SNB output.

This is a box of output!

I made every calculation and graph in this book with Scientific Notebook 5.50 (Build
2960). To write this book, I used Scientific WorkPlace 5.50 (Build 2960), which has
all of SNB’s computational capabilities plus the LATEX typesetting system. To create the
final PDF file, I used Pdf 995 (version 10.2).
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So we’re all on the same page...

For the most part, I’ve left SNB’s default settings unchanged. There is one important
exception. Under the Tools menu item, on the General page of Engine Setup, you
will find the Solve Options. The default setting for Principal Value only and Ignore
Special Cases is unchecked, which when solving equations can lead to output from
SNB that looks like this:

ax2 + bx+ c = 0, Solution is:⎧⎪⎪⎨⎪⎪⎩
C if a = 0 ∧ b = 0 ∧ c = 0
∅ if c �= 0 ∧ a = 0 ∧ b = 0{−1
b c
}

if b �= 0 ∧ a = 0{− 1
2a

(
b−√−4ac+ b2) ,− 1

2a

(
b+

√−4ac+ b2)} if a �= 0

This answer is correct (C is the set all complex numbers, ∅ is the empty set, the ∧
symbol means “and”) and you could cut-and-paste the parts you want. But as is, it’s
cumbersome and contains too much information to be helpful to most students. To
simplify the output, let’s check both Principal Value only and Ignore Special Cases
and solve the equation again.

ax2 + bx+ c = 0, Solution is: − 1
2a

(
b−√b2 − 4ac)

As you can see, SNB returns only the first answer and considers none of the special
cases. Checking Ignore Special Cases while leaving Principal Value only unchecked
produces this output.

ax2 + bx+ c = 0, Solution is: − 1
2a

(
b−√b2 − 4ac) ,− 1

2a

(
b+

√
b2 − 4ac)

Unless otherwise stated, the Solve Options I use in this book are Ignore Special
Cases checked and Principal Value only unchecked.

There are a few not-so-important exceptions as well, which are more a matter of style
and preference than substance. I made the following minor adjustments to the default
settings.
• Under Tools + User Setup, choose the Math page, click the Radical button, and

choose the Square Root button on the left.

• Under Tools + Computation Setup, choose the 2D Plots page. Click Rectangular
and set the Default Plot Interval from zero to five.

• On the same page, click Polar and set the Default Plot Interval from zero to 6.2832
(about 2π).

• On the Plot Layout page, set the Screen Display and Plot Attributes to Plot Only
and choose Displayed for the Placement option.

I keep SNB’s default setting of five digits in its output. Beyond this, I make no attempt
to do significant figures, which I leave to the instructors. To make a global change for
the number of digits in your answers, go to Tools + Computation Setup, choose the
General page and change the Digits Shown in Results setting.
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What is science?

Science is a systematic process to obtain and explain the facts to answer questions about
the physical universe. Science is something you do. The fundamental precept of science
is “look first, then decide”. To be scientific, you can’t make up your mind and then look
for corroborating facts. You must carefully and rigorously gather the facts first, and then
you analyze and interpret them. This prevents you from taking a few anecdotes and
interpreting them as evidence. In science, “anecdotal evidence” is an oxymoron.

Experience suggests the universe operates under cause-and-effect laws. Contrary to the
views espoused by many TV detectives, coincidences are real and they do happen. Take
care not to mistake the occasional coincidence for a cause-and-effect relationship. You
also must be careful not to assume something is inexplicable because you can’t explain
it. The difference between “I don’t know” and “it’s not knowable” is huge. The former
is a wonderful beginning; the latter is a dead end. Science minimizes these mistakes.

The three parts of science are experiment, theory, and the facts.

� � � � �

� � 	 
 � �  
 � � � � 
 � � �

Experiments play two roles. They obtain the facts and they test the predictions of a
theory. Experimenters make careful, controlled measurements to collect data. In science
not all information rises to the level of data, much like not all information rises to the
level of evidence in a courtroom. An experiment must be repeatable and verifiable.
There is no “take my word for it” in science.

There is no truth in science either. Truth is subjective but the facts are objective. When
you seek the truth, the response you get depends on who or how you ask. The facts do
not depend on who or how you ask. Suppose two people decide to settle an argument
with a race. When they return person A says “I won and he lost” while person B says
“I finished just behind the person that won and she finished just ahead of the person that
came in last”. Who is telling the truth? They both are telling a version of the truth. The
facts are person A ran the race in 10 seconds and person B ran the race in 11 seconds.

A scientific theory must do two things. It must explain the known facts and predict new
facts that can be measured experimentally. This ensures that the theory is not simply
“aimed” at only known facts. A theory is rigorous, detailed, and mathematical. A
theoretical result is much more than a hypothetical idea. Don’t say “I have a theory”
when you only have an idea or a guess and don’t say “theoretically” when you mean
“hypothetically”.
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To the Student

Many of you are just beginning to learn physics. Perhaps you have heard that physics is
a difficult course. Many students, even those who have had success in other subjects, are
frightened by the prospect of taking physics for a grade. Physics is simple to understand
but sometimes it’s difficult to learn. Difficult, but not impossible. Ultimately you hold
the key to your success and there are several ways you can help yourself.

• Read your Textbook
Physics books are not novels and you might not understand everything you read the
first time through. Use your text book (and this book) as a resource to look stuff up
and to review. Some students prefer to read the text before the lecture, others after
the lecture, some even do both. You must find the way that works best for you. Either
way, you will find many answers and insights in your text.

• Ask Questions
If there is something in the class or the text that is not clear, please ask! Do not
be embarrassed. You’re in a physics class and the room is full of people who don’t
understand. Yet.

• Work Together
Students who study with other students often are more successful. One of the best
ways to improve your own understanding of a concept is to explain it to someone
else. But remember, the purpose of a study group is to exchange ideas not answers!

• Seek Help
Some problems take more than 15 minutes to solve. Don’t give up! Here’s a rule
of thumb: if you spend a good hour working on a problem, put it aside and visit
your professor. Bring your work, as often an expert can see a small error that was
preventing your success. Visit your professor, teacher, or graduate assistant with
questions, comments, or just to talk physics.

• Time Is Not Always On Your Side
Physics is best learned in small doses. You don’t know in advance which problems
will be the most time consuming, so budget your time wisely. Waiting until the last
minute and trying to cram is not a good strategy. Avoid falling into the “due Monday
means do Sunday” trap.

• Pay More Than Attention
Physics is more a skill rather than a collection of facts. Solving physics problems
is a skill, and like all skills it must be learned by doing. You cannot learn a skill by
reading about it or by listening to your professor talk about it in a lecture. This is
as true for riding a bicycle as it is for learning physics. How much and how well
you learn physics depends mostly on the time and effort you put forth. Educators
guide you, encourage you, offer you our insights. It’s up to you to actually learn the
physics.

In other words, as in most things in life worth doing, success in learning physics requires
hard work and effort.



xx Preface

In most physics courses, you are required to solve word problems. There is no guaran-
teed recipe for successful problem solving. It is a skill that you must acquire through
practice. But I can offer a few words of advice about problem solving.
• Read the problem carefully! The biggest problem with word problems is the words.

• Ask yourself two important questions: “what do I know?” and “what am I trying to
find?”.

• Draw a picture! Visualizing the problem will help you solve it.

• Do the math correctly. SNB will help you with this step.

• Check your units. Are the units right?

• Is the answer reasonable?
There is much more to do than just the math.

The problems at the end of the chapters are rarely “SNB problems” any more than prob-
lems in other physics books are calculator problems. After Chapter 1, there are very few
SNB problems in this book. Most of the problems are physics problems. Remember that
SNB is a tool and we want to do something with it.

To the Teacher

SNB has many features that teachers will find useful. You can use SNB to write home-
work assignments, exams, and solutions. You can use it to write your class notes and
post them on the web so your students can access them with the Open Location com-
mand. SNB uses text files that are easily emailed so you and your students can exchange
questions and answers.

You can create your own document types (ideal for lab reports or in-class worksheets)
with the Export Document command. SNB exports the document as a shell file and
treats it as a template. When your students click the New button, your preferred formats
appears as one of their options.

We all try to be available and encourage our students to contact us. When they do, I
usually use SNB to answer their questions. This is not the traditional approach, and the
soulless minions of orthodoxy may not approve, but it seems to work.

When given a math or physics problem to solve with SNB, students often treat it as an
SNB problem. Remind them SNB is a tool and the goal is to use that tool to do something.

Contact Information

If you have any questions, comments or suggestions about this book, please feel free to
contact me directly at DPwSNB@gmail.com and I’ll respond as quickly as I can.

To find the book’s website, go to http://booksupport.wiley.com/ and search for this book
by my name or the title. Once you’re there, you’ll find the DPwSNB e-book, the solutions
manual, PowerPoint files containing all the figures in this book, and any other goodies
we conjure up.
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1 Introduction to SNB

The main activity of most physics classes is to teach students how to solve physics prob-
lems. Mathematics is a tool we use to solve those problems. Many of the difficulties
students have in physics classes are rooted in the mathematics. They can’t see the for-
est of physics for all the mathematical trees. Scientific Notebook (SNB) is a powerful yet
easy-to-use computer algebra system that can help alleviate this problem. SNB is inex-
pensive and easy enough to be accessible to most undergraduates yet powerful enough
to be useful in solving interesting physics problems.

The goal of this book is to teach students how to use SNB to solve physics problems.
Once you have learned how (and it won’t take all that long), you will use SNB as its
name implies− as a notebook in which you set up a science or math problem, write and
solve an equation, analyze and discuss the results. Of course a regular notebook will
never help you do the math, but SNB will. Soon you will be able to think and write at
the computer, in much the same way you use a paper and pencil now, with the power of
a computer algebra system at your disposal.

Why SNB?

Scientific Notebook is powerful software that combines word processing and mathemat-
ics in standard notation with the power of symbolic computation. You enter the math-
ematical expressions in a form that is familiar to you and SNB evaluates it. This is the
key to SNB. All the mathematics are in standard notation in a form that is familiar to
you. There is no arcane syntax to learn.

Consider a quick analysis of the function y = x2e−3x sin 4x. What is the area under the
curve? Where is the function zero? What does the function look like? You may know
how to find the answers, but you might have trouble doing the necessary mathematics.
With SNB, one click gives the exact answer and a second click gives an approximate
numerical answer.∫ ∞

0

x2e−3x sin 4x dx =
88

15 625
= 5.632× 10−3

With one click, SNB will find the first zero of the function.

0 = x2e−3x sin 4x, Solution is: 0

As you might have guessed, this function equals zero at x = 0.

Doing Physics with Scientific Notebook: A Problem-solving Approach, First Edition. Joseph Gallant.
c© 2012 John Wiley & Sons, Ltd. Published 2012 by John Wiley & Sons, Ltd.



2 Chapter 1 Introduction to SNB

You can see the other zeros with a plot of the function. It would be simple to graph this
function by hand, but tedious and time consuming. To see a 2-dimensional plot of this
function with SNB, we can again click a single button.

1 2 3 4 5

-0.04

-0.03

-0.02

-0.01

0.00

0.01

0.02

0.03

0.04

0.05

x

y

Figure 1.1 A plot of x2e−3x sin 4x

Later in this chapter you’ll learn how to find the other zeros.

Once we created the expressions, which was very easy to do, all it took was a few mouse
clicks to answer our three questions. The entire process took about a minute. With SNB’s
help, you will be able to spend more time thinking about physics and less time worrying
about mathematics. However, keep in mind that SNB can only help you solve physics
problems, it can not solve them for you.

This chapter presents a brief introduction to SNB, emphasizing features you will use in
your physics class. It explains how to perform basic tasks such as entering and editing
mathematics and text, solving equations and how to compute and plot mathematics. You
can even use SNB to open and save documents available on the Internet. Keep in mind
the main advantage of SNB over other systems. It is easy to learn and easy to use yet
powerful enough to do physics. Before you start Doing Physics with SNB, you need to
know how to use SNB.

The Basics

When you start SNB, you see a typical Windows interface containing menus, icons, and
other graphics. This interface allows you to interact with the “brains” of SNB, the engine.
The engine is the program which performs all the mathematical calculations. In version
5.5 of SNB, the engine is MuPAD (version 3.1). SNB translates your input into a form
the engine can understand, sends it to the engine, translates the engine’s output into a
form you can understand, and shows it to you.

Since SNB uses a standard interface, all the editing techniques you use in other pro-
grams will work in SNB. If you are new to computing, all the editing techniques you
learn here will be useful in other applications. The blinking vertical line on your screen
is called the insertion point, and it marks the position where characters or symbols are
entered when you type or click a symbol. You can change the position of the insertion
point with the arrow keys, or by clicking a different screen position with your mouse.
The position of the mouse is indicated by the mouse pointer, which takes the shape of
an I-beam over text and an arrow over mathematics.
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Some actions in SNB require you to select, or highlight, text or mathematics. When you
make a selection with the mouse or the keyboard, the next action you take affects the
selection. To select an individual word or mathematical object with the mouse, double-
click the word or object. To make a large selection with the mouse you can either
click-and-drag the pointer with the left mouse button down, or click the mouse at the
start of the selection, press and hold SHIFT, move the pointer to where you want the
selection to end, click the mouse and release SHIFT. For more information on selecting,
look under Help + Search, Selecting Text and Mathematics.

You can access many of SNB’s features from various toolbars. You can display or hide
any of the toolbars and you can return the toolbar display to its original setting. Also,
you can dock the toolbars in the program window, let them float on the screen, or reshape
them according to your preference. Use the following steps to display or hide toolbars.

1. Go to the View menu and choose Toolbars.

2. Check the box for each toolbar you want to display.

3. Choose Close. If you choose Reset, you will restore the default toolbar display.

The Standard Toolbar contains most of the commands you will need to manage files
and to edit and manipulate text and mathematics in your SNB documents. Many of these
are probably familiar to you. The Open (CTRL + O) command opens an existing file and
the Save command saves the active file and keeps it open. You can Cut (CTRL + X),
Copy (CTRL + C) and Paste (CTRL + V) text, mathematics, and graphics.

Show/Hide
New Save Print Spelling Copy Undo Nonprinting Table

Open Open Preview Cut Paste Properties Toggle Zoom Factor
Location Text/Math

The SNB interface is not what-you-see-is-what-you-get, so use the Preview button to
see what the printed document will look like before you Print (CTRL + P) it. The Zoom
Factor only affects the on-screen appearance of your document and has no effect on the
printed version.

As anyone who has ever graded papers will tell you, it is a good idea to check the
Spelling in your document before printing. With the Spelling tool you can check the
spelling in a selection, from the insertion point to the end of the document, or in the entire
document. You can even check the spelling of a single word by selecting it and clicking
the Spelling button. A spell check does not check mathematics or words embedded in
mathematics.

The Standard Toolbar also includes some SNB commands, including the important
Math/Text toggle button. With the New command you can create a new file by selecting
the type of document from a list of shells provided with SNB. Each shell is a template
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for a different type of SNB document. You can create your own shells by using File
+ Export Document to place any SNB document as a shell file in one of the Shells
folders. Once there, your new file will appear in the shell list displayed when you start a
new document. If you have a required format for lab reports, you could create a shell file
organized in that format. When you need to write a lab report, click New and choose
that shell. You can even create new shell folders to organize your shells. For more
information on creating shells, look in Help + Shells, Creating a Document Shell.

The Open Location command allows you to open an existing SNB file that is posted
on the web as long as you know its URL. Look in the Preface to this book for any
information on a website.

By changing the Properties of any text or mathematical object, you can alter the behav-
ior of mathematical objects and the appearance of your document. Select the item you
want to adjust and click the Properties button. A context-sensitive dialog box will ap-
pear that allows you to change the properties of the item. If you don’t select anything,
SNB chooses the item to the left of the insertion point. Any changes you make only
affect that item.

The Compute Toolbar contains many commands you will use to carry out mathematical
calculations. These are the commands you’ll use most often to solve physics problems.

Solve Plot 3D Show
Evaluate Exact Expand Rectangular Definitions

Evaluate Simplify Plot 2D New
Numerically Rectangular Definition

This chapter devotes significant time and space to these important commands and your
success using SNB depends on you doing the same.

The Stop Toolbar contains a single button

that you can use to stop two operations, linking to the Internet and performing com-
putations. You can also stop these operations by pressing CTRL + BREAK. The Stop
operation is not available from a menu.

Before you carry out any calculations, you need to create mathematical expressions
using the mathematical objects on the Math Templates and Math Objects toolbars.

Unit Big
Fraction Superscript Parentheses Sum Name Operators Matrix Binomial Decoration

Radical Subscript Square Integral Display Brackets Math Label
Brackets Name

Math Templates Math Objects
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Notice the Table button is not here (it is on the Standard Toolbar). Both tables and
matrices are two-dimensional arrays of boxes called cells. Each cell of a table can hold
mathematics, text, or graphics. But a table is not a mathematical object, so you can’t
perform mathematical computations on a table as a whole as you can on a matrix. A
good rule of thumb in SNB: matrices are for numbers and tables are for words.

The Symbol Cache contains 18 commonly used mathematical symbols

including two reserved symbols (π and ∞) and the times sign (× ) used in multiplica-
tion and scientific notation. You will also find these symbols and more in the Symbol
Panels.

Lowercase Binary Negated Miscellaneous General
Greek Operations Relations Symbols Latin-1 Punctuation

Uppercase Binary Arrows Special Latin
Greek Relations Delimiters Extended-A

Each button opens a popup panel of symbols which you can customize to remain open
all the time or dock in a different location. For a detailed look at the symbols on each
panel, look under Help + Search, Symbol Panels.

The buttons on the Editing Toolbar allow you to alter the appearance of the text in
your document. The first four buttons apply frequently used Text Tags: Normal, Bold,
Italics, and Emphasized. To change the appearance of your text, select the text and click
one of these four buttons.

Tag Tag Import
Normal Italics Tags Replace Picture

Tag Tag Find Space User
Bold Emphasized Setup

The Find (CTRL + Q) and Replace (CTRL + W) commands let you search for and re-
place text or mathematics in your document. You can search for all occurrences of any
combination of mathematics and text, including those with a specific Tag. You can also
access the Find and Replace commands from the Edit menu.

With User Setup you can customize many of SNB’s default values. From the User
Setup dialog box, you can choose which shell SNB uses as the start-up document, set
the properties of mathematical objects and operations, the properties of new graphics,
tables and matrices, and many other general program properties. Be very careful when
you alter any settings with User Setup. The changes you make with it are global and
affect every document you open. Use Compute + Settings to make local changes that
affect the current document only.
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The Tag Toolbar consists of three popup lists that contain all the item tags, section and
body tags, and text tags available for the current shell. With these tags, you can organize
your document and alter its appearance.

Remove Item Tag (Alt + 1) Section/Body Tag (Alt + 2) Text Tag (Alt + 3)
Item Tag

As we saw earlier, the Text Tags alter the appearance of text. Besides the four on
the Editing Toolbar, you can find more Text Tags in the right-hand popup list of the
Tag Toolbar. When you click the Text Tag popup box (or press ALT + 3), a list of all
available text tags pop up.

The middle popup list contains Section/Body Tags. You can use the various headings,
centered text, and quotations to organize your document. You can apply Item Tags to
create various kinds of lists. With the Numbered List Item tag you can create a list of
items that are automatically numbered sequentially. With the Bullet List Item tag you
can create a list of items that are preceded by a bullet. All the numbered and bulleted
lists in this book were created with Item Tags. The Description List Item tag allows
you to create a customized text label for each item on your list.

The Fragment Toolbar offers an easy way to save and access frequently used expres-
sions or equations. A fragment contains information (text, mathematics or both) that has
been saved in a separate file for later recall. You can import a previously saved fragment
into the current document, or you can save information in the current document as a new
fragment. A fragment saved in one document is available to all documents. The Frag-
ment Toolbar consists of the Save Fragment button and the fragment popup box.

Fragments (Alt + 4)Save Fragment

When you click the fragment popup box (or press ALT + 4), a list of fragments that
you can insert in your document pops up. SNB comes with many predefined fragments,
including an extensive list of physical constants.

It is very easy to import a fragment into your document.
1. Place the insertion point where you want the fragment to appear.

2. Click the fragment popup box (or press ALT + 4).

3. Click on the fragment you want to import.

You can also use File + Import Fragment... menu item. Just select the fragment
you want from the Import Fragment dialog box and choose OK. When you import a
fragment, its contents are pasted into your document at the insertion point.


